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Pelatihan Data Analytics ini dirancang untuk membekali peserta dengan keterampi-
lan praktis dalam mengelola, menganalisis, dan menyajikan data secara efektif un-
tuk mendukung pengambilan keputusan berbasis data. Materi mencakup empat pilar
utama: Query dan pengolahan data menggunakan Excel, Statistik dasar, Penggunaan
Smartsheet untuk kolaborasi data, serta proyek mini berbasis analitik dan visualisasi
data.

Peserta akan belajar menyaring dan merangkum data menggunakan fungsi Excel dan
Power Query, memahami konsep statistik dasar, mengelola proyek data secara kolab-
oratif melalui Smartsheet, serta mengerjakan proyek analitik seperti prediksi harga,
analisis churn pelanggan, dan dashboard interaktif menggunakan Google Data Studio
atau Power BI.

Pelatihan ini mengedepankan pendekatan praktis berbasis studi kasus dan sangat cocok
untuk profesional dari berbagai latar belakang yang ingin meningkatkan kemampuan
analisis data secara menyeluruh.

## Rundown Pelatihan Data Analytics (2 Hari)

Waktu: 08.00 – 16.00 WIB
Format: Teori 30%, Praktik 70%
Break: 2x Coffee Break + 1x Lunch per hari

Hari 1: Dasar Data Query, dan Visualisasi Excel

Waktu Kegiatan
08.00 – 08.30 Registrasi & Pembukaan Pelatihan
08.30 – 09.30 Sesi 1: Pengenalan Data Analytics & Tools yang Digunakan
09.30 – 10.30 Sesi 2: Query & Analisis Data dengan Excel (Fungsi Dasar &

Logika)
10.30 – 10.45 � Coffee Break 1
10.45 – 12.00 Sesi 3: Power Query – Import & Transformasi Data Otomatis
12.00 – 13.00 � Istirahat & Makan Siang
13.00 – 14.30 Sesi 4: Statistik Deskriptif: Ukuran Pemusatan, Penyebaran, dan

Visual
14.30 – 14.45 � Coffee Break 2

1
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Waktu Kegiatan
14.45 – 15.45 Sesi 5: Pivot Table, Slicer & Dashboard Interaktif di Excel
15.45 – 16.00 Review Hari Pertama & Sesi Tanya Jawab

Hari 2: Smartsheet, Proyek Mini, dan Presentasi

Waktu Kegiatan
08.00 – 09.30 Sesi 1: Pengenalan & Praktik Smartsheet untuk Kolaborasi Data
09.30 – 10.30 Sesi 2: Automasi, Notifikasi, & Laporan Dinamis di Smartsheet
10.30 – 10.45 � Coffee Break 1
10.45 – 12.00 Sesi 3: Proyek Mini – Persiapan & Pemilihan Studi Kasus
12.00 – 13.00 � Istirahat & Makan Siang
13.00 – 14.30 Sesi 4: Visualisasi Data – Google Data Studio / Power BI
14.30 – 14.45 � Coffee Break 2
14.45 – 15.45 Sesi 5: Presentasi Proyek Mini (Per Kelompok/Individu)
15.45 – 16.00 Penutupan, Evaluasi Pelatihan & Foto Bersama



Kata Pengantar

Tentang Penulis

Bakti Siregar, M.Sc., CDS merupakan Dosen pada Program Studi Sains Data, Insti-
tut Teknologi dan Sains Bandung (ITSB). Ia menyelesaikan studi magister di bidang
Matematika Terapan dari National Sun Yat Sen University, Taiwan. Di luar aktivitas
akademik, beliau juga aktif sebagai Data Scientist independen yang telah bekerja sama
dengan berbagai perusahaan ternama seperti JNE, Samora Group, Pertamina, dan PT.
Green City Traffic.

Fokus keahlian beliau meliputi Big Data Analytics, Machine Learning, Optimisasi, dan
Analisis Deret Waktu, khususnya dalam konteks keuangan dan investasi. Ia memi-
liki kompetensi mendalam dalam bahasa pemrograman statistik seperti R dan Python,
serta berpengalaman dalam pengelolaan data menggunakan sistem basis data relasional
(MySQL) dan non-relasional (NoSQL). Selain itu, beliau juga menguasai penggunaan
perangkat Big Data seperti Apache Spark dan Hadoop.

Portofolio proyek dan karya beliau dapat diakses melalui platform berikut: Rpubs,
GitHub, Situs Web Pribadi, dan Kaggle.

Ucapan Terima Kasih
Pelatihan Data Analytics merupakan keterampilan penting dalam menganalisis dan
menyajikan data untuk pengambilan keputusan berbasis data. Modul ini dirancang
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4 Kata Pengantar

untuk memberikan pemahaman praktis dalam menggunakan alat populer seperti Mi-
crosoft Excel dan Google Data Studio, meliputi:

• � Penguasaan pengolahan dan analisis data menggunakan Microsoft Excel

• � Kemampuan untuk membuat visualisasi interaktif dan dashboard
menggunakan Google Data Studio

• � Penerapan konsep dasar analisis data seperti filtering, pivot table, dan
visualisasi tren

• � Integrasi antara pemahaman data dan konteks bisnis atau domain

Buku ini ditujukan bagi peserta pemula yang ingin membangun dasar yang kuat dalam
Data Analytics, khususnya dengan alat yang mudah diakses dan banyak digunakan
di industri.

Saya menyampaikan apresiasi kepada seluruh peserta pelatihan atas keaktifan dan an-
tusiasme dalam sesi diskusi. Semoga materi ini dapat menjadi panduan praktis dalam
penerapan analisis data menggunakan Excel dan Google Data Studio di berbagai sektor
kerja.

Masukan & Saran
Masukan Anda sangat penting untuk penyempurnaan modul ini. Kami sangat terbuka
terhadap saran mengenai isi, alur penyampaian, maupun kejelasan materi. Ide-ide
tambahan terkait fitur Excel atau visualisasi lanjutan di Google Data Studio juga sangat
kami hargai.

Dengan partisipasi dan kontribusi Anda, kami berharap E-book ini terus berkembang
menjadi referensi yang bermanfaat dalam dunia Data Analytics. Terima kasih atas
dukungan Anda!

Untuk saran dan masukan, silakan hubungi:

• dsciencelabs@outlook.com

• siregarbakti@gmail.com

• siregarbakti@itsb.ac.id
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Chapter 1

Pengenalan Excel

Microsoft Excel adalah salah satu aplikasi pengolah data yang paling populer dan
banyak digunakan dalam berbagai bidang, mulai dari bisnis, keuangan, pendidikan,
hingga penelitian. Excel menyediakan berbagai fitur untuk analisis data, perhitun-
gan matematis dan statistik, manajemen data, serta visualisasi melalui grafik
dan chart.

1.1 Navigasi Antarmuka Excel

Untuk memaksimalkan penggunaan Excel, penting memahami elemen dasar dari antar-
muka pengguna (user interface), yaitu:

• Ribbon: Baris menu utama di bagian atas jendela Excel, terdiri dari tab-tab
seperti Home, Insert, Page Layout, Formulas, Data, Review, dan View. Setiap
tab berisi kelompok perintah yang berkaitan.

• Toolbar (Quick Access Toolbar): Terletak di pojok kiri atas, toolbar ini berisi
perintah yang sering digunakan seperti Save, Undo, dan Redo.

• Worksheet (Lembar Kerja): Area utama tempat pengguna memasukkan dan
mengelola data. Worksheet terdiri atas grid dari:

– Kolom: Vertikal, ditandai dengan huruf A, B, C, …
– Baris: Horizontal, ditandai dengan angka 1, 2, 3, …
– Sel (Cell): Titik temu antara kolom dan baris, memiliki alamat unik seperti

A1.

Berikut ini adalah contoh sederhana untuk penjelasan Navigasi Antarmuka Excel
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1.2 Struktur Data dalam Excel
Setiap sel dapat menyimpan berbagai jenis data:

• Teks (String): Misalnya, “Jakarta”, “Produk A”.
• Numerik (Angka): Seperti 100, 3.14, atau -25.
• Logika (Boolean): TRUE atau FALSE.
• Tanggal dan Waktu: Seperti 12/06/2025 atau 14:30.
• Formula dan Fungsi:

– Rumus: =A1+B1
– Fungsi dasar: =SUM(A1:A10), =AVERAGE(B2:B10), =IF(A1>100,"Lulus","Tidak

Lulus")

1.3 Pengelolaan Lembar Kerja
• Workbook: File Excel yang dapat berisi satu atau lebih worksheet. Ekstensi file:

.xlsx (modern) atau .xls (lama).
• Sheet Tabs: Terletak di bagian bawah, menampilkan nama masing-masing work-

sheet. Pengguna dapat menambah, mengganti nama, memindah, atau menghapus
sheet.
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1.4 Dasar Menggunakan Excel
1. Memasukkan data ke dalam sel secara manual atau dengan copy-paste.
2. Menyusun data dalam bentuk tabel agar lebih rapi.
3. Menggunakan fungsi dasar:

• =SUM(A1:A10)
• =MAX(B2:B10)
• =COUNT(C1:C20)

4. Memformat sel:
• Menyesuaikan ukuran font, warna latar, dan batas sel.

1.5 Shortcut Excel
Berikut adalah tabel shortcut Excel untuk Windows dan Mac dalam format Markdown
code:

Fungsi Shortcut (Windows) Shortcut (Mac)
Salin (Copy) Ctrl + C Cmd + C
Tempel (Paste) Ctrl + V Cmd + V
Potong (Cut) Ctrl + X Cmd + X
Simpan (Save) Ctrl + S Cmd + S
Buka File (Open) Ctrl + O Cmd + O
Tutup Workbook Ctrl + W Cmd + W
Undo (Batalkan) Ctrl + Z Cmd + Z
Redo (Ulangi) Ctrl + Y Cmd + Y atau Cmd +

Shift + Z
Pilih Semua Ctrl + A Cmd + A
Cari (Find) Ctrl + F Cmd + F
Ganti (Replace) Ctrl + H Ctrl + H
Masuk ke sel tertentu (Go
To)

Ctrl + G / F5 Fn + F5

Cetak (Print) Ctrl + P Cmd + P
Tambah lembar baru (New
Sheet)

Shift + F11 Fn + Shift + F11

Navigasi ke kiri/kanan tab
worksheet

Ctrl + Page Up/Down Fn + Cmd + ↑/↓

Masuk ke mode Edit sel F2 Ctrl + U
Insert baris baru Ctrl + Shift + "+" Cmd + Shift + K
Hapus baris/kolom Ctrl + - Cmd + -
Autofit kolom Alt + H, O, I Ctrl + Option +

Command + 0
Bold (Tebal) Ctrl + B Cmd + B
Italic (Miring) Ctrl + I Cmd + I
Underline (Garis bawah) Ctrl + U Cmd + U
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Chapter 2

Fungsi Esensial di Excel

Fungsi-fungsi dalam Excel dan Google Sheets sangat membantu dalam analisis dan
pengolahan data. Mereka memungkinkan pengguna untuk melakukan perhitungan
berdasarkan kondisi tertentu, pencarian data secara efisien, serta manipulasi teks den-
gan mudah. Penguasaan fungsi-fungsi pada tabel di bawah ini dapat meningkatkan
efektivitas dan akurasi dalam pengelolaan data.

Fungsi
Kategori
Fungsi Kegunaan Singkat

IF Logika/Dasar Menentukan hasil berdasarkan syarat tertentu
IFS Logika/Dasar Menentukan hasil berdasarkan beberapa kondisi

secara berurutan
SUMIF Statistik

Kondisional
Menjumlahkan data sesuai kriteria

SUMIFS Statistik
Kondisional

Menjumlahkan data berdasarkan banyak kriteria

COUNTIF Statistik
Kondisional

Menghitung data yang memenuhi satu syarat

COUNTIFS Statistik
Kondisional

Menghitung data yang memenuhi beberapa syarat

AVERAGEIF Statistik
Kondisional

Menghitung rata-rata dengan satu kondisi

AVERAGEIFS Statistik
Kondisional

Menghitung rata-rata dengan banyak kondisi

VLOOKUP Pencarian/ReferensiMencari data dari kolom paling kiri dan
mengembalikan nilai di kolom lain

HLOOKUP Pencarian/ReferensiMencari data dari baris paling atas
XLOOKUP Pencarian/ReferensiFungsi lookup modern yang menggantikan

VLOOKUP dan HLOOKUP
INDEX Pencarian/ReferensiMengambil data dari koordinat baris dan kolom

tertentu
MATCH Pencarian/ReferensiMencari posisi dari suatu nilai dalam rentang
INDEX+MATCH Pencarian/ReferensiKombinasi pencarian fleksibel dan akurat
CHOOSE Referensi/Pilihan Memilih nilai dari daftar berdasarkan nomor indeks

11
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Fungsi
Kategori
Fungsi Kegunaan Singkat

LEFT Manipulasi Teks Mengambil karakter dari sisi kiri teks
RIGHT Manipulasi Teks Mengambil karakter dari sisi kanan teks
MID Manipulasi Teks Mengambil karakter dari posisi tengah teks
LEN Manipulasi Teks Menghitung panjang karakter dalam teks
TRIM Manipulasi Teks Menghapus spasi berlebih dari teks
CONCAT Manipulasi Teks Menggabungkan beberapa teks
TEXT Format/Konversi Mengubah angka menjadi teks sesuai format
NOW Waktu &

Tanggal
Mengambil tanggal dan waktu saat ini

TODAY Waktu &
Tanggal

Mengambil tanggal hari ini

IFERROR Error Handling Menangani kesalahan dan memberikan nilai
alternatif

ISBLANK Logika/Validasi Mengecek apakah sel kosong
SPLIT Manipulasi Teks Memisahkan teks berdasarkan pemisah tertentu

(tersedia di Excel 365 & Google Sheets)
UNIQUE Data

Manipulasi
Mengambil daftar nilai unik dari sebuah rentang
data

2.1 Dataset Kesehatan Pekerja
Dataset yang digunakan dalam materi ini berjudul Dataset_Kesehatan_Pekerja.xlsx.
File ini disusun dalam format multi-sheet Excel, yang terdiri atas satu sheet utama
dan tiga sheet tambahan untuk mendukung praktik penggunaan Fungsi Esensial di
dalam Excel.

2.1.1 Sheet Utama: Data Utama
Sheet ini berisi informasi kesehatan dan riwayat medis 50 orang pekerja, yang
meliputi:

• Identitas dasar pekerja:
KODE PEKERJA, NIPP, NAMA PEKERJA, TANGGAL LAHIR, JENIS KELAMIN, JABATAN,
UNIT KERJA, dan KEDUDUKAN.

• Rekam medis tahun 2022 hingga 2024, termasuk:

– Nilai MCU
– Diagnosis dari hasil Medical Check Up

• Riwayat tambahan:

– RIWAYAT HABITUAL (kebiasaan seperti merokok, olahraga, konsumsi alkohol)
– RIWAYAT PSIKOSOSIAL (masalah keuangan, rumah tangga, atau stabil)
– RIWAYAT PENYAKIT TERDAHULU

• Data kematian, meliputi:

– TANGGAL KEMATIAN
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– KATEGORI PENYEBAB KEMATIAN
– DIAGNOSIS UTAMA PENYEBAB KEMATIAN
– KRONOLOGIS PENYEBAB KEMATIAN (dalam narasi berbahasa Indonesia)

Sheet ini dirancang agar dapat digunakan untuk latihan: - Fungsi logika: IF - Fungsi
agregasi bersyarat: SUMIF, COUNTIF, AVERAGEIF - Fungsi pencarian data: VLOOKUP,
INDEX, MATCH

2.1.2 Sheet Tambahan
Data Pekerja

Berisi daftar referensi pekerja berdasarkan KODE PEKERJA, digunakan untuk praktik
fungsi pencarian data identitas antar-sheet.

Data Unit

Berisi daftar KODE UNIT dan BAGIAN KESEHATAN, berguna untuk melakukan lookup
unit kerja pada data utama.
Contoh praktik: menghubungkan unit kerja dengan bagian kesehatan menggunakan
VLOOKUP.

Data Diagnosis

Berisi daftar referensi kode dan nama diagnosis: - KODE DIAGNOSIS - NAMA DIAGNOSIS

Sheet ini digunakan untuk mengonversi kode diagnosis menjadi nama penyakit
yang dapat dipahami secara medis.

2.2 Tujuan Penggunaan Dataset
Dengan struktur data yang lengkap dan realistis ini, pengguna dapat:

• Belajar berbagai fungsi penting Excel secara kontekstual
• Melakukan simulasi pengolahan data kesehatan karyawan
• Mengasah keterampilan membuat dashboard, melakukan validasi data, dan

analisis kesehatan
• Menerapkan konsep relasi antar-sheet di Excel menggunakan fungsi pencarian

Dataset ini ideal digunakan dalam pelatihan data entry, analisis data kesehatan, serta
pembuatan laporan berbasis Excel.

2.3 Fungsi Dasar
2.3.1 IF
Gunanya: Membuat keputusan berdasarkan suatu kondisi dengan logika “Jika … Maka
…”

Contoh:
=IF(E2="Laki-laki"; "Pria"; "Wanita")
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Jika E2 adalah “Laki-laki”, maka hasilnya “Pria”, jika tidak maka “Wanita”.

2.3.2 IFS
Gunanya: Mengevaluasi beberapa kondisi secara berurutan.

Contoh:
=IFS(A2>45; "Senior"; A2>35; "Junior"; A2<=35; "Beginer")

atau,
=IF(A2>45; "Senior"; IF(A2>35; "Junior"; "Beginer"))

Menentukan nilai huruf berdasarkan skor.

2.4 Statistik Kondisional
2.4.1 SUMIF
Gunanya: Menjumlahkan hanya data yang sesuai dengan syarat tertentu.

Contoh:
=SUMIF('Data Diagnosis'!B2:B45;"Serangan Jantung";'Data Diagnosis'!C2:C45)

2.4.2 COUNTIF
Gunanya: Menghitung berapa banyak data yang memenuhi suatu kondisi.

Contoh:
=COUNTIF('Data Diagnosis'!B2:B45; "Serangan Jantung")

Hitung jumlah kasus diagnosis “Serangan Jantung” di tahun 2024.

2.4.3 AVERAGEIF
Gunanya: Mengambil rata-rata dari data yang memenuhi kriteria.

Contoh:
=AVERAGEIF('Data Diagnosis'!B2:B45;"Serangan Jantung";'Data Diagnosis'!C2:C45)

2.5 Pencarian
2.5.1 VLOOKUP
Gunanya: Digunakan untuk mencari data berdasarkan nilai pada kolom pertama su-
atu tabel, kemudian mengambil nilai dari kolom lain yang berada di baris yang sama.
VLOOKUP mencari secara vertikal (dari atas ke bawah)

Contoh:



2.5. PENCARIAN 15

=VLOOKUP(A2;'Data Utama'!$B$1:$X$51;9;FALSE)

Cari KODE UNIT di sheet Data Unit, ambil Bagian UNIT KERJA pada
sheet Data Utama

2.5.2 HLOOKUP
Gunanya: Digunakan untuk mencari data berdasarkan nilai pada baris pertama suatu
tabel, lalu mengambil nilai dari baris lain yang berada di kolom yang sama. HLOOKUP
mencari secara horizontal (dari kiri ke kanan).

Contoh: Hasil yang sama seperti VLOOKUP.
=HLOOKUP(F1;TRANSPOSE('Data Utama'!$B$2:$T$51);9;FALSE)

Cari KODE UNIT di sheet Data Unit, ambil Bagian UNIT KERJA pada
sheet Data Utama

2.5.3 XLOOKUP
Gunanya: Fungsi pencarian modern yang menggantikan VLOOKUP dan HLOOKUP.
Lebih fleksibel dan tidak bergantung pada urutan kolom atau baris.

Contoh:
=XLOOKUP(A2; B2:B100; C2:C100)

Cari nilai A2 di kolom B, lalu ambil nilai terkait di kolom C.

2.5.4 INDEX
Gunanya: Mengambil data berdasarkan posisi baris dan kolom.

Contoh:
=INDEX(B2:B51; 5)

Ambil data dari baris ke-5 kolom B.

2.5.5 MATCH
Gunanya: Memberi tahu posisi data dalam kolom atau baris.

Contoh:
=MATCH("DAOP 2 BANDUNG"; N2:N51; 0)

Posisi baris diagnosis “DAOP 2 BANDUNG” di kolom N.

2.5.6 INDEX + MATCH
Digunakan untuk mengambil data dari sebuah tabel atau rentang berdasarkan penco-
cokan baris dan/atau kolom, sebagai alternatif yang lebih fleksibel dan kuat dibanding
VLOOKUP atau HLOOKUP.

Kelebihan dibanding VLOOKUP/HLOOKUP:
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Fitur VLOOKUP INDEX + MATCH

Cari ke kiri? � Tidak bisa � Bisa
Performa lebih cepat? � Tidak � Ya (terutama tabel besar)
Insert kolom aman? � Rentan error � Aman
Lebih fleksibel? � Terbatas � Sangat fleksibel

Contoh:
=INDEX('Data Utama'!A:X; MATCH(A2; 'Data Utama'!B:B; 0); 10)

Cari KODE UNIT di sheet Data Unit, ambil Bagian UNIT KERJA pada
sheet Data Utama

2.5.7 CHOOSE
Gunanya: Memilih nilai dari daftar berdasarkan indeks yang ditentukan.

Contoh:
=CHOOSE(2; "A"; "B"; "C")

Menghasilkan “B” karena indeks 2.

2.6 Manipulasi Teks
2.6.1 LEFT, RIGHT, MID
Gunanya: Mengambil bagian teks berdasarkan posisi karakter.

Contoh:
=LEFT(A2; 5)
=RIGHT(A2; 4)
=MID(A2; 3; 2)

Mengambil 5 karakter pertama, 4 karakter terakhir, dan 2 karakter dari
posisi ke-3.

2.6.2 LEN
Gunanya: Menghitung jumlah karakter dalam teks.
=LEN(A2)

2.6.3 TRIM
Gunanya: Menghapus spasi ekstra di awal, tengah, dan akhir teks.
=TRIM(A2)
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2.6.4 CONCAT
Gunanya: Menggabungkan beberapa sel atau teks.
=CONCAT(A2; " "; B2)

2.6.5 SPLIT
Gunanya: Memisahkan teks berdasarkan pemisah tertentu (Excel 365/Google Sheets).
=SPLIT(A2; ",")

2.7 Format dan Konversi
2.7.1 TEXT
Gunanya: Mengubah angka menjadi teks dalam format tertentu.
=TEXT(TODAY(); "dd-mm-yyyy")

2.8 Waktu dan Tanggal
2.8.1 NOW, TODAY

=NOW() → Tanggal & waktu sekarang
=TODAY() → Tanggal hari ini

2.9 Validasi dan Penanganan Error
Excel menyediakan berbagai fungsi untuk memvalidasi data dan menangani error secara
otomatis. Dengan memanfaatkan fungsi-fungsi ini, kita dapat mengantisipasi potensi
masalah, menampilkan pesan yang lebih informatif, atau mengganti hasil error dengan
nilai yang lebih berguna.

Fungsi-fungsi ini sangat berguna saat:

Menghindari hasil seperti #DIV/0!, #N/A, atau #VALUE! dalam laporan. Mengecek
apakah suatu sel kosong atau berisi angka/teks/logika. Memberikan alternatif hasil
jika suatu formula gagal. Tabel berikut merangkum fungsi-fungsi utama untuk validasi
dan penanganan error di Excel beserta penjelasan dan contohnya.

Fungsi Penjelasan Contoh Penggunaan
IFERROR Mengembalikan nilai alternatif jika

formula menghasilkan error
=IFERROR(A2/B2; "Error!")

IFNA Sama seperti IFERROR, tetapi hanya
menangani error #N/A

=IFNA(VLOOKUP(D2;A2:B5;2;FALSE);
"Data tidak ditemukan")

ISERROR Mengecek apakah hasil formula
adalah error (jenis apa pun)

=ISERROR(A2/B2)
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Fungsi Penjelasan Contoh Penggunaan
ISNA Mengecek apakah nilai adalah error

#N/A
=ISNA(VLOOKUP(D2;A2:B5;2;FALSE))

ISBLANK Mengecek apakah sebuah sel kosong =ISBLANK(A2)
ISNUMBER Mengecek apakah nilai adalah angka =ISNUMBER(A2)
ISTEXT Mengecek apakah nilai adalah teks =ISTEXT(A2)
ISLOGICALMengecek apakah nilai adalah TRUE

atau FALSE
=ISLOGICAL(A2)

ISFORMULAMengecek apakah sel berisi formula =ISFORMULA(A2)
ERROR.TYPEMengembalikan kode numerik untuk

jenis error tertentu
=ERROR.TYPE(A2)

2.10 Fungsi Manipulasi Data
Saat mengolah data di Excel, kita sering kali perlu mengatur ulang, mengubah format,
atau membersihkan isi sel agar data lebih mudah dianalisis dan disajikan. Fungsi ma-
nipulasi data memungkinkan kita untuk mengekstrak bagian dari teks, menggabungkan
beberapa informasi, memformat angka atau tanggal, hingga menghapus spasi berlebih
yang tidak terlihat namun bisa mengganggu analisis.

Fungsi-fungsi ini sangat penting terutama saat:

Menggabungkan nama depan dan belakang dari dua kolom. Mengambil kode atau
substring dari teks (seperti kode unit, inisial, dsb.). Membersihkan data hasil impor
dari sistem lain. Mengubah angka menjadi teks dengan format tertentu (misal: “Rp”
atau “01/01/2025”). Dengan fungsi-fungsi manipulasi data ini, kamu dapat memben-
tuk ulang data mentah menjadi informasi yang siap pakai untuk laporan, dashboard,
maupun analisis lanjutan.

Berikut adalah daftar fungsi manipulasi data yang umum digunakan di Excel, lengkap
dengan kegunaan dan contohnya:

Fungsi Penjelasan Contoh Penggunaan
FILTER Menyaring data berdasarkan kondisi tertentu =FILTER(A2:B10;

B2:B10="Lulus")
SORT Mengurutkan data (menaik/turun)

berdasarkan kolom tertentu
=SORT(A2:B10; 2;
TRUE)

SORTBY Mengurutkan data berdasarkan urutan kolom
tertentu tanpa mengubah sumber

=SORTBY(A2:B10;
B2:B10; 1)

TRANSPOSE Mengubah orientasi baris � kolom =TRANSPOSE(A1:D1)
SEQUENCE Membuat urutan angka otomatis (array

dinamis)
=SEQUENCE(5;1;1;1)

RAND Menghasilkan angka acak antara 0 dan 1 =RAND()
RANDBETWEENMenghasilkan angka acak dalam rentang

tertentu
=RANDBETWEEN(1;100)

UNIQUE Menghasilkan daftar nilai unik dari rentang
data

=UNIQUE(A2:A100)
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Fungsi Penjelasan Contoh Penggunaan
TEXTSPLIT Memisahkan teks menjadi beberapa

kolom/baris (khusus Excel 365)
=TEXTSPLIT(A1; ",")

TEXTJOIN Menggabungkan teks dari beberapa sel dengan
pemisah tertentu

=TEXTJOIN(", ";
TRUE; A2:A5)

SCAN Melakukan kalkulasi kumulatif pada array
(Excel 365)

=SCAN(0; A2:A5;
LAMBDA(a,b; a+b))

REDUCE Mereduksi array menjadi satu nilai melalui
logika tertentu (Excel 365)

=REDUCE(0; A2:A5;
LAMBDA(a,b; a+b))

LET Mendefinisikan variabel dalam formula untuk
efisiensi & keterbacaan

=LET(x; A1*2; x+5)

LAMBDA Membuat fungsi buatan sendiri langsung di
Excel (Excel 365)

=LAMBDA(x; x^2)(4)
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Chapter 3

Power Query

Di Excel, “Query Data” berarti mengambil, menggabungkan, dan memfilter data dari
berbagai sumber menggunakan Power Query atau fitur bawaan Excel.

3.1 Proses Power Query
Berikut ini adalah proses melakukan Power Query di Excel:

1. Buka Excel, lalu ke tab “Data”
2. Klik “Get Data” > Pilih sumber data (misalnya: “From File” > “From Work-

book”)
3. Pilih file sumber, lalu klik “Import”
4. Di jendela Power Query Editor, lakukan transformasi:

• Filter kolom
• Merge/join tabel
• Ubah tipe data
• Tambah kolom hitung

5. Klik “Close & Load” untuk menyimpan hasil ke worksheet

Mengimpor Data dari Berbagai Sumber Power Query memungkinkan pengguna
mengambil data dari:

File Excel, CSV, Text Folder (untuk menggabungkan banyak file otomatis) Database
(SQL Server, MySQL, PostgreSQL, dsb) Web (API atau halaman HTML) SharePoint,
OneDrive, dan sumber cloud lainnya � Tujuan: Menghubungkan data dari berbagai
sumber tanpa menyalin manual.

3.2 Mengenal Editor Power Query
Editor Power Query mewakili antarmuka pengguna Power Query. Di antarmuka peng-
guna ini, pengguna dapat menambahkan atau memodifikasi kueri, mengelola kueri
dengan mengelompokkan atau menambahkan deskripsi ke langkah-langkah kueri, atau
memvisualisasikan kueri pengguna dan strukturnya dengan tampilan yang berbeda. An-
tarmuka pengguna Power Query memiliki lima komponen yang berbeda.

21
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1. Pita: pengalaman navigasi pita, yang menyediakan beberapa tab untuk menam-
bahkan transformasi, memilih opsi untuk kueri pengguna, dan mengakses tombol
pita yang berbeda untuk menyelesaikan berbagai tugas.

2. Panel kueri: tampilan semua kueri yang tersedia.
3. Tampilan saat ini: tampilan kerja utama pengguna, yang secara default,

menampilkan pratinjau data untuk kueri pengguna. Pengguna juga dapat men-
gaktifkan tampilan diagram bersama dengan tampilan pratinjau data. pengguna
juga dapat beralih antara tampilan skema dan tampilan pratinjau data sambil
mempertahankan tampilan diagram.

4. Pengaturan kueri: tampilan kueri yang saat ini dipilih dengan informasi yang
relevan, seperti nama kueri, langkah-langkah kueri, dan berbagai indikator.

5. Bilah status: bilah yang menampilkan informasi penting yang relevan tentang
kueri pengguna, seperti waktu eksekusi, total kolom dan baris, dan status pem-
rosesan. Bilah ini juga berisi tombol untuk mengubah tampilan pengguna saat
ini.

3.3 Membersihkan Data
Kegiatan ini mencakup:

• Menghapus kolom/baris yang tidak dibutuhkan
• Mengganti nilai (Replace Values)
• Menghapus nilai kosong / duplikat
• Menstpenggunarkan data (huruf besar/kecil, penghilangan spasi)
• Mengganti tipe data (text → number, text → date, dsb)

Tujuan: Menyediakan data yang rapi dan konsisten sebelum analisis.

3.4 Transformasi Data
Transformasi struktur data termasuk:

• Split Column → Memecah isi kolom menjadi beberapa
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• Merge Column → Menggabungkan dua atau lebih kolom jadi satu
• Pivot & Unpivot → Ubah baris menjadi kolom dan sebaliknya
• Group By → Mengelompokkan data dan melakukan agregasi (jumlah, rata-rata,

dll)
• Sort & Filter → Mengurutkan dan menyaring data
• Add Column → Menambahkan kolom kustom (termasuk rumus)

Tujuan: Menyusun data dalam bentuk yang sesuai untuk laporan atau analisis.

3.5 Penggabungan Data
Merge Queries → Menggabungkan dua tabel seperti VLOOKUP Append Queries →
Menumpuk dua atau lebih tabel (seperti UNION)

Tujuan: Menggabungkan berbagai sumber atau periode data menjadi satu set data
utuh.

3.6 Otomatisasi & Refresh
Setelah membuat langkah-langkah transformasi:

Semua langkah tersimpan sebagai “Applied Steps” pengguna bisa refresh data kapan
saja untuk memuat data terbaru dari sumber aslinya, tanpa perlu ulang proses manual
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Chapter 4

Pivot Table & Slicer

4.1 Pivot Table
Pivot Table adalah alat di Excel yang digunakan untuk menganalisis, meringkas,
dan memvisualisasikan data dalam bentuk tabel interaktif.

4.1.1 Fungsi Pivot Table
• Meringkas data besar dengan cepat (misalnya total penjualan per bulan)
• Menyusun data dalam bentuk hierarki (wilayah → cabang → toko)
• Melakukan perhitungan (SUM, AVERAGE, COUNT, dsb)
• Mengelompokkan data berdasarkan kategori

4.1.2 Membuat Pivot Table
1. Siapkan data bersih dalam bentuk tabel (Ctrl + T)
2. Klik Insert → Pivot Table
3. Pilih lokasi pivot (New Worksheet atau Existing Worksheet)
4. Di area Pivot Table Fields, seret:

• Kolom kategori ke Rows
• Kolom nilai ke Values
• Kolom waktu/region ke Columns (opsional)
• Kolom filter ke Filters (opsional)

4.2 Grouping
Pengelompokan Data di Pivot Table adalah untuk membentuk kategori baru. Seperti
halnya, grup untuk angka, teks, atau tanggal (contoh: bulan, kuartal, range umur).

Cara Melakukan Grouping:

1. Pilih nilai/label di Pivot Table
2. Klik kanan → pilih Group
3. Untuk tanggal, Excel akan memberi opsi Group by: Days, Months, Quarters,

Years

25



26 CHAPTER 4. PIVOT TABLE & SLICER

4. Untuk angka, bisa buat interval (misal: 0–99, 100–199, dst)

Contoh:

• Data penjualan harian → Group by Month
• Data usia karyawan → Group by tiap 10 tahun

4.3 Penerapan Slicer
Slicer adalah alat visual untuk memfilter data Pivot Table secara interaktif.
Cocok untuk dashboard karena tampilannya menarik dan mudah digunakan.

Cara Menambahkan Slicer:

1. Klik di dalam Pivot Table
2. Pilih Pivot Table Analyze → Insert Slicer
3. Centang field yang ingin dijadikan kontrol filter (misalnya Produk, Wilayah, Bu-

lan)
4. Slicer akan muncul sebagai tombol filter

Fitur Slicer:

• Bisa klik satu atau beberapa item
• Bisa dihubungkan ke lebih dari satu Pivot Table
• Mudah diatur tampilannya (warna, kolom, ukuran tombol)

4.4 Power Query � Pivot Table � Slicer

Alat Peran Utama
Power Query Membersihkan dan membentuk data sumber
Pivot Table Menganalisis dan menyajikan data dalam ringkasan
Grouping Mengelompokkan data di Pivot Table
Slicer Menyaring tampilan Pivot Table secara visual
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Dashboard Interaktif

Dashboard adalah antarmuka visual yang menyajikan data kesehatan karyawan secara
ringkas dan informatif agar pengambilan keputusan terkait kesehatan dan manajemen
risiko lebih cepat dan akurat.

5.1 Desain Layout Dashboard

5.1.1 Prinsip Desain

1. Tujuan Jelas
• Apa yang ingin disampaikan? (Status kesehatan karyawan? Diagnosa

utama? Tren penyakit? Angka kematian?)
2. Tata Letak Hierarkis

• Informasi utama seperti jumlah kasus diagnosa dan kematian diletakkan di
bagian atas

• Detail tambahan dan filter ditempatkan di samping atau bawah
3. Pembagian Area Dashboard:

• Header: Judul, filter periode tahun, unit kerja

• Panel Kiri: Filter (unit kerja, jenis kelamin, usia, jabatan)

• Panel Tengah: Visualisasi utama (grafik tren diagnosa, distribusi penyakit)

• Panel Kanan: KPI Box dan insight cepat (jumlah kasus, biaya pengobatan)
4. Gunakan Warna Konsisten

• Hijau = sehat, Kuning = risiko sedang, Merah = kasus kritis atau kematian

• Gunakan palet warna 2–4 warna agar mudah dibaca
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5.2 Kombinasi Grafik
5.2.1 Grafik

• Line chart → tren kasus penyakit atau diagnosis dari tahun ke tahun

• Bar chart → perbandingan jumlah kasus per unit kerja atau jabatan

• Pie chart → proporsi jenis penyakit utama

• Boxplot → distribusi usia dan biaya pengobatan

5.2.2 KPI Box
KPI Box (Key Performance Indicator) adalah ringkasan angka penting terkait kesehatan
karyawan:

KPI Contoh
Jumlah Karyawan Sehat 500 orang
Jumlah Kasus Diagnosa 2024 120 kasus
Kasus Kematian 2022-2024 5 kasus
Total Biaya Pengobatan Rp 75.000.000
Rata-rata Usia Karyawan 42 tahun

Gunakan angka besar dan jelas, sertakan simbol tren naik/turun jika ada
perubahan

5.2.3 Filter Interaktif
• Periode Tahun: 2022, 2023, 2024

• Unit Kerja: Palopo, Banda Aceh, Jakarta, dll.

• Jenis Kelamin: Laki-laki, Perempuan

• Jabatan: Manajer, Supervisor, Petugas, Operator

• Status Kesehatan: Sehat, Sakit, Meninggal

5.3 Studi Kasus
Membuat Dashboard Kesehatan Karyawan 2022–2024

5.3.1 Tujuan
Memantau status kesehatan, diagnosis utama, dan kematian karyawan berdasarkan unit
kerja dan jabatan.
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5.3.2 Data
• Kode Pekerja, Nama, Jabatan, Unit Kerja

• Diagnosa MCU 2022-2024

• Riwayat habitual dan psikososial

• Tanggal kematian dan penyebab

• Berat badan, tinggi badan

• Biaya pengobatan

5.3.3 Layout Dashboard:
1. Header:

• Judul: Dashboard Kesehatan Karyawan

• Filter: [Tahun] [Unit Kerja] [Jabatan]
2. KPI Box (atas):

• Jumlah Karyawan Sehat per Tahun

• Jumlah Kasus Diagnosa Utama

• Kasus Kematian dan Penyebab
3. Grafik Utama (tengah):

• Line chart: Tren kasus diagnosa utama dari 2022-2024

• Bar chart: Kasus per unit kerja dan jabatan

• Pie chart: Proporsi jenis penyakit utama
4. Detail Table (bawah):

• Tabel data lengkap karyawan dengan kolom filter dan pencarian

5.3.4 Insight
• Tren peningkatan atau penurunan kasus penyakit tertentu per tahun

• Unit kerja atau jabatan dengan kasus penyakit tertinggi

• Penyebab utama kematian dan potensi risiko kesehatan

• Rata-rata biaya pengobatan dan pola distribusinya

5.3.5 Tools Visualisasi
• Excel / Google Sheets: untuk dashboard statis dan cepat
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• Google Studio/ Power BI / Tableau: untuk dashboard interaktif dan
visualisasi kompleks

• R Shiny / Python Dash / Streamlit: untuk dashboard berbasis coding dan
analisis lanjutan

• Looker Studio / Metabase: untuk dashboard real-time terintegrasi dengan
database

� Tips Sukses:
- Buat dashboard mudah dipahami dengan layout bersih
- Fokus pada insight penting yang membantu pengambilan keputusan
- Sertakan anotasi untuk menjelaskan poin kritis data
- Perbarui data secara berkala agar dashboard tetap relevan

5.4 Grafik Esensial
Visualisasi membantu memahami pola, penyebaran, dan hubungan dalam data — pent-
ing dalam analisis kesehatan kerja, epidemiologi industri, serta evaluasi keselamatan
kerja.

5.4.1 Histogram
Definisi: Visualisasi distribusi data numerik dalam bentuk interval (bin).

Fungsi:

• Menampilkan frekuensi data dalam kelompok
• Mengidentifikasi bentuk distribusi (normal, skewed)

Contoh:

Distribusi kadar kolesterol pekerja:

Bin (mg/dL) Frekuensi
150–170 2
171–190 5
191–210 8
211–230 3

� Interpretasi: Mayoritas pekerja memiliki kolesterol antara 191–210 mg/dL.

5.4.2 Bar Chart
Definisi:

Visualisasi data kategori menggunakan batang vertikal/horizontal.

Fungsi:

• Membandingkan frekuensi antar kategori

Contoh:

Jumlah kasus cedera per jenis pekerjaan:
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• Operator: 15 kasus

• Mekanik: 8 kasus

• Administrasi: 3 kasus

� Interpretasi: Operator memiliki jumlah cedera tertinggi.

5.4.3 Pie Chart
Definisi:

Representasi persentase kategori dalam satu lingkaran.

Fungsi:

• Menunjukkan proporsi relatif

Contoh:

Proporsi jenis penyakit:

• Hipertensi: 40%

• Diabetes: 35%

• Asma: 25%

� Interpretasi: Hipertensi paling dominan (40%).

Hindari pie chart untuk kategori terlalu banyak (>5), lebih baik gunakan
bar chart.

5.4.4 Line Chart
Definisi:

Visualisasi data berurutan waktu (time series).

Fungsi:

• Melihat tren dari waktu ke waktu

Contoh: Jumlah kunjungan klinik per bulan:

Bulan Jumlah
Jan 12
Feb 15
Mar 18
Apr 10

� Interpretasi: Terjadi peningkatan di Maret, kemungkinan karena musim atau pa-
paran tinggi.
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5.4.5 Boxplot
Definisi:

Visualisasi ringkasan statistik: median, kuartil, dan outlier

Fungsi:

• Menilai penyebaran dan outlier
• Bandingkan distribusi antar kelompok

Contoh:

Boxplot kadar hemoglobin antara dua shift kerja

� Interpretasi:

• Median shift malam lebih rendah
• Ada outlier kadar Hb rendah pada shift malam

5.5 Analisis Distribusi dan Outlier
Tujuan:

Menilai bentuk dan keanehan distribusi

Langkah:

1. Gunakan histogram atau boxplot
2. Cek simetri:

• Simetris → distribusi normal
• Miring kanan/kiri → skewed

3. Identifikasi outlier:
• Data jauh dari Q1 – 1.5 IQR atau Q3 + 1.5 IQR
• Bisa jadi kesalahan input atau kondisi khusus

Contoh Outlier:

Seorang pekerja memiliki kadar kolesterol 300 mg/dL saat mayoritas < 220 mg/dL.

� Tindak Lanjut: Perlu diselidiki — mungkin ada faktor medis atau gaya hidup ek-
strem.

5.6 Pengantar Korelasi dan Tren
5.6.1 Korelasi:
Menilai hubungan antar dua variabel numerik

Contoh:

• Usia pekerja dan tekanan darah
• Paparan zat berbahaya dan fungsi paru

Jenis Korelasi:

• Positif: semakin X → Y meningkat (contoh: umur ↑ → tekanan darah ↑)
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• Negatif: semakin X → Y menurun
• Nol: tidak ada hubungan

Visualisasi:

Gunakan scatter plot

5.6.2 Tren
Tren adalah pola perubahan data dalam waktu.

Contoh:

• Kecenderungan peningkatan keluhan muskuloskeletal dari tahun ke tahun
• Penurunan kadar hemoglobin setelah diterapkan program nutrisi

� Analisis lanjutan: Gunakan regresi linier untuk mengukur tren secara kuantitatif.

� Tips Penting: - Gunakan histogram dan boxplot untuk data numerik. -
Gunakan bar chart/pie chart untuk data kategori. - Gunakan scatter plot
& line chart untuk hubungan dan tren.
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Chapter 6

Join Table

Programmer database menggunakan pernyataan join SQL untuk menggabungkan data
dari tabel yang berbeda. Di Looker Studio, Anda dapat menggabungkan data tanpa
menulis kode. Sebagai gantinya, Anda menggunakan editor penggabungan (blend edi-
tor) untuk mengatur join, seperti yang ditunjukkan pada tangkapan layar berikut:

##cLegenda

• Tabel
• Konfigurasi Join
• Tombol Tambah Tabel Join
• Nama Blend
• Dimensi dan Metrik yang Disertakan
• Tambahkan metrik, rentang tanggal, dan filter
• Opsi: Sembunyikan Field Join yang Diulang
• Tombol Simpan (SAVE)
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6.1 Tabel

Blended data terdiri dari beberapa tabel.
Saat kamu mengedit atau membuat blend, tabel-tabel ini akan ditampilkan di antar-
muka pengguna (UI).

Setiap tabel berisi kumpulan field (kolom) yang diambil dari sumber data.
Satu blend dapat memiliki hingga 5 tabel.

Untuk menambahkan data ke tabel:

• Klik Add dimension (tambahkan dimensi)
• Klik Add metric (tambahkan metrik)

� Field yang digunakan dalam kondisi join ditandai dengan ikon rantai/link
�.

6.2 Konfigurasi Join

Join configuration (konfigurasi penggabungan) menghubungkan pasangan tabel
dalam sebuah blend.

Konfigurasi ini terdiri dari:

• Operator Join: cara menggabungkan data yang cocok dan tidak cocok
• Kondisi Join: field yang menghubungkan antar tabel

Contoh:

• Tabel Grades di-join dengan tabel Students berdasarkan field student_id
• Tabel Grades juga di-join dengan tabel Classes berdasarkan field class_id
• Kedua join menggunakan operator Left Outer Join

Artinya: semua data dari tabel utama (Grades) ditampilkan,
dan hanya data yang cocok dari Students atau Classes yang ikut diga-
bungkan.
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Join operator menentukan bagaimana baris yang cocok (matching) dan tidak cocok
(non-matching) dari tabel-tabel yang digabungkan (blend) akan disatukan.
Looker Studio mendukung beberapa jenis operator join sebagai berikut:

6.2.1 Inner Join
• � Mengembalikan hanya baris yang cocok antara tabel kiri dan kanan.
• � Baris yang tidak memiliki pasangan di tabel lain akan dihilangkan.

Contoh:

Jika NIP hanya ada di tabel A dan juga di tabel B, maka hanya baris tersebut yang
ditampilkan.

6.2.2 Left Outer Join (default)
• � Menampilkan semua baris dari tabel kiri
• � Tambahkan data dari tabel kanan jika ada yang cocok
• � Jika tidak cocok, nilai dari tabel kanan akan kosong (null)

Contoh: Semua karyawan dari tabel A tetap ditampilkan, meskipun tidak ada data
medis di tabel B.

6.2.3 Right Outer Join
• � Menampilkan semua baris dari tabel kanan
• � Tambahkan data dari tabel kiri jika ada yang cocok
• � Jika tidak cocok, data dari tabel kiri akan kosong (null)
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6.2.4 Full Outer Join
• � Menggabungkan semua baris dari tabel kiri dan kanan
• � Menyertakan data meskipun tidak ada pasangan di tabel lainnya
• Nilai dari tabel yang tidak cocok akan null

6.2.5 Cross Join
• � Menghasilkan semua kombinasi baris antara tabel kiri dan kanan
• � Gunakan dengan hati-hati — jumlah baris bisa sangat besar (perpangkatan)

Contoh: Jika tabel A memiliki 3 baris dan tabel B punya 2 baris → hasilnya = 6 baris

� Catatan Penting:
Dalam praktiknya, Left Outer Join adalah yang paling sering digunakan
karena menjamin semua data dari tabel utama tetap muncul.
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Dashboard Looker Studio

Berikut adalah instruksi lengkap dan detail untuk membuat dashboard Looker Studio
berdasarkan data survey karyawan terkait riwayat kesehatan, kebiasaan, psikososial,
dan kematian yang dikumpulkan melalui Google Form (tersimpan di Google Sheet):

7.1 Langkah 1
Persiapan Data di GForm

• Pastikan Anda telah membuat Google Form dengan pertanyaan seperti:
– Nama, Jabatan, Tahun, Diagnosa, Riwayat Penyakit, Kebiasaan Buruk,

Kondisi Psikososial, Status Hidup, Penyebab Kematian, Total Biaya
• Data akan otomatis masuk ke Google Sheets.

7.2 Langkah 2
Hubungkan Google Sheets ke Looker Studio

1. Buka https://lookerstudio.google.com
2. Klik Blank Report
3. Pilih Google Sheets sebagai data source
4. Pilih file hasil Google Form > worksheet: Form Responses 1
5. Klik Tambahkan ke Laporan

7.3 Langkah 3
Buat Visualisasi Dashboard

7.3.1 Kontrol Filter
• Tambahkan: Dropdown List untuk:

– Jabatan
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– Tahun
– Status Hidup
– Diagnosa

7.3.2 Scorecards
• Total Responden: Count of Nama
• Total Meninggal: Gunakan filter Status Hidup = Meninggal
• Total Biaya Pengobatan: SUM(Total Biaya)

7.3.3 Bar Chart
Diagnosa Terbanyak:

• Dimensi: Diagnosa
• Metrik: Count of Nama
• Sortir: Descending

7.3.4 Pie Chart
Kebiasaan Buruk

• Dimensi: Kebiasaan Buruk
• Metrik: Count of Nama

7.3.5 Line Chart
Tren Biaya Pengobatan per Tahun

• Dimensi: Tahun
• Metrik: SUM(Total Biaya)

7.3.6 Stacked Bar
Psikososial

• Dimensi: Kondisi Psikososial
• Metrik: Count of Nama

7.3.7 Donut Chart
Status Hidup

• Dimensi: Status Hidup
• Metrik: Count of Nama

7.3.8 Tree Map
Penyebab Kematian

• Dimensi: Penyebab Kematian
• Metrik: Count of Nama
• Filter: Status Hidup = Meninggal
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7.3.9 Tabel Detil
• Kolom: Nama, Jabatan, Diagnosa, Kebiasaan Buruk, Psikososial, Biaya, Status

Hidup

7.4 Langkah 4
Format dan Desain

• Warna:
– Hijau: Kesehatan
– Oranye: Kebiasaan
– Biru: Psikososial
– Hitam/Abu: Kematian

• Tambahkan Header, Spacer, dan penamaan bagian.

7.5 Langkah 5
Simpan & Bagikan

• Klik Bagikan
• Atur akses publik/terbatas sesuai kebutuhan
• Bisa disematkan di intranet/situs internal

7.6 Tips Tambahan
• Jangan ubah struktur kolom Google Sheet
• Update data otomatis setiap kali ada isian baru
• Gunakan parameter/filter lanjutan jika perlu analisis dinamis
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Koneksi ke GDrive

Untuk menghubungkan Looker Studio (sebelumnya Google Data Studio) dengan data
yang ada di Google Drive, kamu bisa menggunakan Google Sheets sebagai perantaranya.
Berikut adalah langkah lengkap untuk koneksi data dari Google Drive ke Looker Studio:

8.1 Langkah 1
Siapkan Data di Google Drive. Pastikan file kamu dalam format Google Sheets atau
convert dari Excel:

• Buka Google Drive.
• Upload file Excel (jika perlu).
• Klik kanan → Open with → Google Sheets.
• File akan tersimpan otomatis dalam format Google Sheets.

8.2 Langkah 2
Atur Izin Akses File

1. Pastikan kamu adalah owner atau memiliki akses editor ke file.
2. (Opsional) Untuk akses tim:

• Klik Share di kanan atas Google Sheets.
• Pilih Anyone with the link (Viewer/Editor) jika diperlukan.

8.3 Langkah 3
Hubungkan ke Looker Studio

1. Buka Looker Studio.
2. Klik + Blank Report atau buka report yang sudah ada.
3. Klik tombol Add data (ikon +).
4. Pilih Google Sheets sebagai konektor.
5. Cari dan pilih file dari Google Drive.
6. Pilih worksheet yang akan digunakan → klik Add.
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7. Klik Add to Report untuk menambahkan ke dashboard.

8.4 Langkah 4
Buat Visualisasi dari data riwayat kesehatan karyawan:

• � Jumlah diagnosis per tahun
• � Tren penyakit seperti hipertensi dan diabetes
• � � Korelasi jabatan dengan biaya kesehatan
• � Perbandingan kebiasaan merokok vs kondisi medis

Catatan Tambahan

• Data akan otomatis ter-refresh di Looker Studio saat isi Google Sheets diper-
barui.

• Hindari sheet dengan lebih dari 100.000 baris untuk performa terbaik.
• Gunakan filter di Google Sheets untuk menyederhanakan data besar.



Part III

Smartsheet

47





Chapter 9

Pengenalan Smartsheet

Smartsheet adalah platform kolaborasi berbasis cloud yang digunakan untuk manaje-
men proyek, pelacakan tugas, dan otomatisasi alur kerja dengan antarmuka yang mirip
spreadsheet. Smartsheet menggabungkan kemudahan penggunaan seperti Excel dan
Google Sheets dengan fitur kolaborasi dan manajemen proyek tingkat lanjut.

9.1 Cara Menggunakan Smartsheet
1. Membuat Akun dan Login

• Buka smartsheet.com

• Daftar menggunakan email kerja atau pribadi

• Login ke dashboard utama
2. Membuat Sheet Baru

• Klik tombol + Create atau Create New

• Pilih Blank Sheet atau gunakan template yang sudah tersedia

• Beri nama sheet sesuai proyek atau kebutuhan
3. Menambahkan Data

• Klik sel pada sheet dan mulai mengetik

• Tambah baris atau kolom jika perlu dengan tombol “+” di header kolom
atau bawah baris

• Gunakan tipe kolom khusus seperti Dropdown, Checkbox, atau Date untuk
input data yang terstruktur

4. Membuat dan Menggunakan Form
• Buka sheet yang ingin ditambahkan form

• Klik tab Forms di bagian atas dan pilih Create Form
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• Sesuaikan pertanyaan dan layout form

• Bagikan link form untuk mengumpulkan data yang otomatis masuk ke sheet
5. Membuat Report

• Klik Create New lalu pilih Report

• Pilih sheet atau beberapa sheet yang menjadi sumber data

• Atur filter dan kolom yang ingin ditampilkan

• Simpan dan bagikan report sesuai kebutuhan
6. Berbagi dan Kolaborasi

• Klik tombol Share di pojok kanan atas sheet atau report

• Masukkan email orang yang ingin diajak bekerja sama

• Atur hak akses: Viewer, Editor, Admin

• Kolaborator dapat mengedit, komentar, atau hanya melihat sesuai izin
7. Menggunakan View yang Berbeda

• Ubah tampilan sheet dengan memilih Grid, Gantt, Card, atau Calendar
View sesuai kebutuhan

• Manfaatkan Gantt untuk penjadwalan proyek, Card untuk manajemen tugas,
dan Calendar untuk monitoring tanggal penting

8. Automasi dan Notifikasi
• Klik Automation di toolbar atas

• Buat aturan otomatis seperti pengingat, update status, atau pengiriman
email

• Atur notifikasi agar tim selalu update dengan perubahan terbaru

9.2 Navigasi Smartsheet
1. Dashboard Utama

Saat login, kamu akan melihat dashboard utama yang menampilkan semua sheet,
laporan, dan dashboard yang kamu miliki atau yang dibagikan kepadamu.

2. Sidebar Navigasi

• Home: Menampilkan daftar sheet, laporan, dan dashboard

• Sheets: Daftar semua sheet yang kamu buat atau akses

• Reports: Tempat laporan yang dibuat dari berbagai sheet

• Forms: Form input data yang bisa dibuat dan dibagikan

• Workspaces: Folder kerja untuk mengelompokkan proyek atau tim
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3. Toolbar Sheet

• Grid View: Tampilan spreadsheet standar

• Gantt View: Tampilan timeline proyek

• Card View: Tampilan seperti Kanban board

• Calendar View: Menampilkan tanggal tugas dalam kalender

4. Bar Alat & Menu

• Menyediakan fitur untuk menambah baris, kolom, formula, filter, dan
pengaturan sharing

• Pengaturan notifikasi dan otomatisasi alur kerja

9.3 Excel vs Google Sheets vs Smartsheet

Fitur Excel Google Sheets Smartsheet
Platform Desktop & Online Online Online

(Cloud-based)
Kolaborasi
Real-time

Terbatas, lewat
OneDrive

Sangat baik,
real-time

Sangat baik,
real-time

Otomatisasi Alur
Kerja

Terbatas (VBA) Terbatas (Script
Editor)

Kuat, dengan
Automation Rules

Manajemen
Proyek

Tambahan Plugin /
Manual

Manual via
Add-ons

Built-in: Gantt,
Card, Kalender

Forms Input
Data

Tidak ada Terintegrasi
(Google Forms)

Built-in, mudah
dibuat

Integrasi
Aplikasi

Office Suite,
banyak add-ins

Google Workspace Banyak integrasi
lewat API &
Zapier

Penggunaan Lebih cocok untuk
analisis dan
pengolahan data

Kolaborasi &
sharing data

Manajemen proyek
& kolaborasi tim

9.4 Sheet, Form, dan Report
9.4.1 Sheet

• Sheet adalah lembar kerja utama di Smartsheet yang menyerupai spreadsheet.

• Dapat berisi baris dan kolom, formula, lampiran, komentar, dan lainnya.

• Bisa menggunakan berbagai jenis kolom: teks, tanggal, dropdown, checkbox, sim-
bol status, dan angka.
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9.4.2 Form
• Form adalah alat untuk mengumpulkan data dari pengguna lain secara mudah

dan terstruktur.

• Data yang diinput melalui form otomatis masuk ke sheet yang terkait.

• Cocok digunakan untuk survei, input data lapangan, permintaan kerja, dan
lain-lain.

• Form dapat dibagikan melalui tautan atau disematkan di website.

9.4.3 Report
• Report menggabungkan data dari satu atau beberapa sheet berdasarkan filter

tertentu.

• Berguna untuk menganalisa data dari berbagai sumber tanpa mengubah sheet asli.

• Report bisa menampilkan data secara tabel, memfilter berdasarkan kondisi, dan
disesuaikan layout-nya.

• Membantu dalam pelaporan dan pengawasan proyek atau tugas.
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Automasi dan Kolaborasi

10.1 Notifikasi Otomatis
Smartsheet memungkinkan pengguna membuat notifikasi otomatis untuk mempercepat
proses kerja dan memastikan tugas tidak terlewat.

10.1.1 Reminder
Reminder digunakan untuk mengingatkan pengguna tentang tenggat waktu atau tugas
yang harus diselesaikan.

• Cara membuat Reminder:
1. Klik menu Automation > Create a Workflow.
2. Pilih Alert someone.
3. Tentukan kondisi pemicu, seperti tanggal mendekati (misalnya, 1 hari se-

belum tanggal “Due Date”).
4. Pilih penerima notifikasi.
5. Simpan workflow.

10.1.2 Approval
Approval memungkinkan pengguna menyetujui atau menolak tugas melalui email lang-
sung dari notifikasi.

• Cara membuat Alur Persetujuan:

1. Klik Automation > Create a Workflow.
2. Pilih Request an approval.
3. Pilih kondisi pemicu (misalnya, status berubah menjadi “Submit”).
4. Tentukan kolom keputusan (Approved/Rejected).
5. Kirim permintaan persetujuan ke email terkait.

10.2 Alur Kerja Automatisasi
Automatisasi membantu mempercepat proses bisnis dan mengurangi pekerjaan manual.

53



54 CHAPTER 10. AUTOMASI DAN KOLABORASI

• Komponen utama:
– Trigger (pemicu): perubahan pada sheet, tanggal, atau pengisian data.
– Kondisi: filter tambahan (misalnya hanya jika status = “Ready”).
– Action: kirim notifikasi, minta persetujuan, update sel, dll.

• Contoh:
“Kirim email ke manajer jika status proyek menjadi ‘Delayed’ ”.

10.3 Berbagi Hak Akses
Smartsheet memungkinkan berbagi file secara kolaboratif dengan berbagai level akses.

• Jenis akses:
– Viewer: hanya bisa melihat
– Editor: bisa mengedit isi
– Admin: mengatur struktur dan kolom
– Owner: kepemilikan penuh

• Cara berbagi sheet:
1. Klik tombol Share.
2. Masukkan email pengguna.
3. Pilih tingkat akses.
4. Klik Send.

10.4 Studi Kasus
10.4.1 Pelacakan Proyek Mingguan dengan Form Input dan No-

tifikasi Email
Tujuan: Memantau perkembangan proyek mingguan dari tim melalui form online dan
otomatisasi email.

Langkah-langkah:

1. Buat Sheet dengan kolom: Nama Proyek, Tanggal Laporan, Status, Catatan.
2. Buat Form dari sheet untuk diisi tim proyek setiap minggu.
3. Aktifkan notifikasi email ke manajer proyek saat form diisi.
4. Tambahkan workflow untuk reminder jika laporan mingguan belum masuk pada

hari Jumat sore.
5. Buat report lintas sheet untuk merangkum status proyek semua tim setiap minggu.

Hasil:

Tim lebih disiplin mengisi laporan. Manajer mendapat update rutin tanpa harus mem-
inta manual.
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Proyek Mini & Presentasi
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Chapter 11

Studi Kasus

11.1 Tujuan Proyek
Mengumpulkan dan menganalisis data dari karyawan PT KAI terkait 5 studi kasus
(untuk 5 Kelompok) penting di bidang Kesehatan dan Keselamatan Kerja (K3), meng-
gunakan Google Form dan menampilkannya dalam dashboard interaktif Looker Studio.

11.2 Pilih Studi Kasus
11.2.1 Kelelahan Kerja dan Shift Panjang

• Fokus: Efek jam kerja panjang pada kesehatan dan keselamatan.
• Contoh Pertanyaan:

– Berapa jam Anda bekerja dalam 1 hari?
– Seberapa sering Anda merasa kelelahan saat bekerja?
– Apakah Anda pernah mengalami insiden saat shift malam?

11.2.2 Penggunaan Alat Pelindung Diri (APD)
• Fokus: Kepatuhan dan efektivitas penggunaan APD.
• Contoh Pertanyaan:

– Apakah Anda diberi APD lengkap saat bekerja?
– Seberapa sering Anda menggunakan APD sesuai prosedur?
– Jenis APD yang paling sering Anda gunakan?

11.2.3 Insiden dan Kecelakaan Kerja
• Fokus: Frekuensi, penyebab, dan tindak lanjut dari kecelakaan kerja.
• Contoh Pertanyaan:

– Pernahkah Anda mengalami kecelakaan kerja?
– Apakah insiden dilaporkan dan ditindaklanjuti?
– Siapa yang menangani pertama kali?
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11.2.4 Kesehatan Mental dan Beban Kerja
• Fokus: Stres kerja dan kesejahteraan mental.
• Contoh Pertanyaan:

– Apakah Anda merasa stres saat bekerja?
– Apakah Anda punya akses ke layanan konseling?
– Seberapa mendukung atasan Anda terhadap kesehatan mental?

11.2.5 Ergonomi dan Posisi Kerja
• Fokus: Posisi kerja dan dampaknya terhadap tubuh.
• Contoh Pertanyaan:

– Apakah Anda merasa pegal saat bekerja?
– Apakah fasilitas kerja ergonomis?
– Jenis keluhan fisik yang sering dirasakan?

11.3 Langkah Teknis
11.3.1 1. Buat Google Form

• Buat 1 Form untuk setiap studi kasus.
• Gunakan format:

– Skala Likert (1–5)
– Pilihan Ganda
– Checkbox
– Grid Jawaban

• Pastikan jawaban otomatis direkam ke Google Sheet.

11.3.2 2. Koneksikan ke Looker Studio
• Buka Looker Studio → Tambahkan Data → Google Sheets.
• Pilih Sheet hasil Form masing-masing studi kasus.
• Gunakan Filter: Departemen, Shift, Usia, Jenis Kelamin.

11.3.3 3. Desain Dashboard Interaktif
Visualisasi yang dapat digunakan:

• Bar Chart → Distribusi jawaban
• Pie Chart → Proporsi pemakaian APD
• Time Series → Tren insiden atau stres kerja
• Table (dengan conditional formatting)
• Filter Panel untuk interaksi pengguna

11.4 Tips Visualisasi
• Gunakan warna PT KAI (biru tua, oranye, abu-abu).
• Tambahkan ilustrasi atau ikon kategori.
• Tampilkan ringkasan data (misal: “40% pekerja shift malam merasa kelelahan

tiap minggu”).
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• Letakkan filter (dropdown atau checkbox) di bagian atas dashboard.
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